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Introduction

Cisco Configuration Assistant (CCA), part of the Cisco Smart Business
Communications System (SBCS) portfolio of products, simplifies the tasks of
configuring, deploying, and administering Cisco network solutions, improves the
security and performance of your network, and reduces the time needed for
network deployment and configuration. Designed for small business networks
from 8 to more than 100 users, this PC-based application with a Graphical User
Interface (GUI) provides everything you need to set up a small office network.

New Features in CCA 3.2.1

CCA 3.2.1 is a minor software release that contains the following features and user
interface changes.

In addition to the changes listed below, see “Limitations and Restrictions,
page 18” for important information that applies to CCA release 3.2.1.

Feature Description

New phone Limited support for SIP Phone models CP-8961, CP-

support 9951, CP-9971, and Cisco Jabber for iPhone.

New gateway Limited support for SPA8000 and SPA8800 (FXS only)

support gateways. For the SPA8800, FXO ports cannot be
configured through CCA.

Release Notes for Cisco Configuration Assistant 3.2.1



Release Notes

System Requirements

The system requirements are described in these sections:
= Installation Requirements, page 3

« Managed Device Support, page 6

Installation Requirements

The PC on which you install Cisco Configuration Assistant must meet these
minimum requirements.

NOTE System requirements for processor, memory, display resolution, and disk
space have been increased.
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System Requirements

Operating
Systems
Supported
(Windows)

Microsoft Windows Vista® Ultimate (32-bit or 64-bit
edition).

Microsoft Windows XP® Professional, Service Pack 2 or
later.

Microsoft Windows 7® (64-bit and 32-bit).

You must have write permission to your home directory and
to the CCA installation directory; so that CCA can create
the necessary log files and preference files.

For PCs running Windows Vista and Windows 7,
Administrator privileges are required in order to update,
install, and use CCA.

NOTE When using CCA on PCs running Microsoft
Windows 7, set the auto sleep function to Never. To change
the PC’s setting follow these steps:

Go to Control Panel > Power Options.
By default, it is set to Balanced.

Click Change when computer sleeps

Increase “Put computer to sleep” from 5 minutes
(default) to Never

Mac OS Support
(requires
virtualization
software)

Mac OS: 10.5 and later

Virtual OS: Parallels Desktop 3.1 and later or VMware
Fusion 1.0 and later

Guest OS: Microsoft Windows XP (Service Pack 2 or later),
Microsoft Windows Vista Ultimate. CCA also supports
remote control via Virtual Network Computing (VNC)
clients.

Hardware

PC with FastEthernet or higher LAN port

Processor

1.8 GHz Intel Core 2 Duo or higher

Disk Space

400 MB recommended
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System Requirements

Memory At least 2 GB for Windows 7, Windows XP, and Windows
Vista.

Display Screen resolution: 1280 x 1024 or higher recommended

Browser Microsoft Internet Explorer 8.0 or later is recommended,

with Javascript enabled.

The Adobe® Flash® Player 10 or later plug-in for Microsoft
Internet Explorer must also be installed (in addition to any
other version of the Flash plug-in that you may have
installed for different Web browsers).

Javascript must be enabled for the Microsoft Internet
Explorer browser.
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Managed Device Support

CCA manages the following phones, switches, routers, access points, wireless
LAN controllers, and IP video cameras.

Table1 Managed Device Support

Device Type Models

Cisco UC500 | UCbH20 Platform
Series

Platform UC520-8U-4FX0O-K9

UC520W-8U-4FX0O-K9
UC520-8U-2BRI-K9
UC520W-8U-2BRI-K9
UC520-16U-4FX0O-K9
UC520W-16U-4FX0O-K9
UC520-16U-2BRI-K9
UC520W-16U-2BRI-K9
UC520-24U-8FX0O-K9
UC520-24U-4BRI-K9
UC520-32U-8FX0-K9
UC520-32U-4BRI-K9
UC520-48U-12FX0O-K9
UC520-48U-6BRI-K9
UC520-48U-T/E/F-K9
UC520-48U-T/E/B-K9

UC540 Series Platform

UC540W-FXO-K9
UC540W-BRI-K9

UC560 Series Platform

UC560-FXO-K9
UC560-BRI-K9
UC560-T1E1-K9
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Table1 Managed Device Support

Device Type Models

Modules and VIC-4FXS/DID

Interface VIC2-2BRI-NT/TE

Cards VIC2-2FXO
VIC2-4FXO
VIC2-FXS

VIC3-2FXS/DID
VIC3-4FXS/DID
VWIC2-1MFT-T1/E1
VWIC2-2MFT-T1/E1
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Table1 Managed Device Support

Device Type

Models

Phones

Cisco Model 6900 Series IP phones:

6961
6941
6921
6911 (NOTE: Video unsupported)
6901 (NOTE: Video unsupported)

NOTE Model 6945 is not supported.

Cisco Unified IP Phones 7900 Series, all models:

7940G
7960G
7975G
7971G-GE
7970G
7965G
7962G
7961G
7961G-GE
7945G
7942G
7941G
7941G-GE
7937G
7931G
7911G

Cisco Unified IP Phone 8900/9900, following models:

8961
9951
9971
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Table1 Managed Device Support

Device Type Models

Phones Cisco SPA 500 Series IP Phones, all models:

(continued) .
SPA525G2 5-Line

SPA525G 5-Line

SPA509G 12-Line
SPA508G 8-Line

SPA504G 4-Line

SPA502G 1-Line

SPA501G Basic 8-Line
SPA500S Expansion Module

Cisco SPA 300 Series IP Phones, all models:

SPAS301
SPA303

Cisco CP-521/524 phones
Cisco IP Communicator

Cisco Jabber for iPhone
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Table1 Managed Device Support

Device Type

Models

Switches

Catalyst Express 520 switches, all models
Cisco ESW500 Series switches, all models

ESW-520-8P 8-Port FastEthernet Switch with PoE
ESW-540-8P 8-Port Gigabit Ethernet Switch with PoE

ESW 520-24, 24-Port 10/100, non-PoE
ESW 520-24P, 24-Port 10/100, PoE
ESW 520-48, 48-Port 10/100, non-PoE
ESW 520-48P, 48-Port 10/100, PoE

ESW 540-24, 24-Port 10/100/1000, non-PoE
ESW 540-24P, 24-Port 10/100/1000, PoE
ESW-540-48, 48-Port 10/100/1000, non-PoE

SF 300 Series models
SG 300 Series models
SF 200 Series models
SG 200 Series models

NOTE: SG200-08 and SG200-08P switches are not
supported.

Routers

Cisco Unified Communications 500 Series platform, all models

Cisco SA500 Series Security Appliances, all models (SA520,
SA520W, and SA540)

Cisco Services Ready Platform SRP500 Series, all models,
discovery and cross-launch of native Web-based
Configuration Utility only.

Cisco 800 Series Routers: Models 831, 836, 851, 851W, 857,
857W,871,871W, 876, 876W, 877,877M,877W, 878, and
878W

Access
Points

Cisco Small Business Pro AP54 1N Dual-band Single-radio
Access Points

Cisco 521 Wireless Express Controller-Based Access Points

Cisco 521 Wireless Express Autonomous Access Points

10
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Downloading and Installing Cisco Configuration Assistant

STEP 1

STEP 2

STEP 3

STEP 4

STEP 5

STEP 6

To install CCA on your PC, follow these steps:

Go to www.cisco.com/go/configassist. You must be a registered Cisco.com user,
but you need no other access privileges.

In the Support information box, click the Download Software link.

If you are not already logged in, you are redirected to the Cisco.com log in page.
Enter your Cisco.com username and password to log in.

Locate the CCA installer file, for example:
cisco-config-assistant-win-k9-3 2-en.exe

Download the CCA installer and run it. You can run the installer directly from the
web if your browser offers this choice. CCA is free; there is no charge to
download, install, or use it.

When you run the installer, follow the on-screen instructions. On the final page click
Finish to complete the installation.

Available and Deferred CCA Versions

The following CCA releases are available for download from Cisco.com:
CCA 3.21
CCA 3.2
CCA 3.1

All other versions of CCA are deferred and are no longer available on Cisco.com.

Updating Cisco Configuration Assistant

Cisco strongly recommends that you upgrade your CCA to the latest version in
order to take advantage of new features and resolved issues.
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STEP 1

STEP 2

STEP 3

STEP 4

You can use the automated Application Updates feature to update Cisco
Configuration Assistant to a later release in the language that you are using. Follow
these steps:

Start Cisco Configuration Assistant.
Choose System > Application Updates.

In the Authentication window, enter your Cisco.com username and password and
click OK.

In the Application Updates window, click Yes.

NOTE Cisco Configuration Assistant 2.x installations cannot be updated to
version 3.0 and later using the Application Update process. You must download
Cisco Configuration Assistant from Cisco.com (www.cisco.com/go/configassist)
and install it manually.

Cisco UC500 Software Packs

Cisco UC500 Software Packs are large zip files that contain all necessary files for
the Cisco UC500 Series platform. Each zip file contains multiple TAR/archive files
for the components of the UC500, including:

I0S image for the UC500 platform

IP Phone firmware files

Voice mail software

Factory default configurations for each SKU

Support files, such as Basic ACD prompts and scripts, ringtones, and
desktop images

Separate UC500 software package files are provided for the Model UC520,
UC540, and UC560 platforms. You must download the correct .zip file for your
UC500 platform (UC520_8.6.0.zip, UC540_8.6.0.zip, or UC560_8.6.0.zip).

12
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Cisco UC500 Locale Packs

UC500 Locale Packs contain the software needed to localize voicemail and
phones (locales for Cisco Model 79xx, SPA525, SPA50x, and CP-52x phones).

This means that you only need to download one file to localize voice mail and all
supported phone models.

A locale pack can be provided when installing software on the UC500 via CCA in
order to install an alternate language on the UC500. Up to two languages can be
installed, an active language and an alternate language.

UC500_8.6.0_locale_da_DK.zip (Danish)
UC500_8.6.0_locale_de_DE.zip (German)
UC500_8.6.0_locale_en_GB.zip (UK English)
UC500_8.6.0_locale_en_US.zip (US English)
UC500_8.6.0_locale_es_ES.zip (European Spanish)
UC500_8.6.0_locale_es_MX.zip (Mexican Spanish)
UC500_8.6.0_locale_fr_FR.zip (European French)
UC500_8.6.0_locale_fr_CA.zip (Canadian French)
UC500_8.6.0_locale_it_IT.zip (Italian)
UC500_8.6.0_locale_nl_NL.zip (Dutch)
UC500_8.6.0_locale_no_NO.zip (Norwegian)
UC500_8.6.0_locale_pt_PT.zip (Portuguese)
UC500_8.6.0_locale_sv_SE.zip (Swedish)

Downloading Cisco UC500 Software and Locale Packs

To download Cisco UC500 Software Packs, go to the following URL:
www.cisco.com/go/uc500swpk

IP phone localization files and voice mail localization files are also available from
this URL. A Cisco.com login is required.
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Available Software Packs

These UC500 software packs are available for download:

« Table 2, “Cisco UC520 Software Packages,” on page 14

= Table 3, “Cisco UC540 Software Packages,” on page 14

= Table 4, “Cisco UC560 Software Packages,” on page 15

Table 2 Cisco UC520 Software Packages

UC520 Software Filename CCA Version Component/Version Information
Pack Version Compatibility
8.6.0 for UC520 UC520_8.6.0.zip (US/English) CCA 3.2.1 and later Cisco I0S 15.1(4) M4b

CUCME 8.6

CUE 8.6.3

B-ACD scripts v4

UC520 factory default configurations
8.2.0 for UC520 UC520_8.2.0.zip (US/English) CCA 3.0 and later Cisco IOS 15.1(2) T4

CUCME 8.2

CUE 8.0.3

B-ACD scripts v3.0.0.2

UC520 factory default configurations

Table 3 Cisco UC540 Software Packages

UC 540 Software
Pack Version

Filename

CCA Version
Compatibility

Component/Version Information

8.6.0 for UC540

UC540_8.6.0.zip (US/English)

CCA 3.2.1 and later

Cisco I0S 15.1(4) M4b

CUCME 8.6

CUE 8.6.3

B-ACD scripts v4

UC540 factory default configurations

8.2.0 for UC540

UC540_8.2.0.zip (US/English)

CCA 3.0 and later

Cisco I0S 15.1(2) T4

CUCME 8.2

CUE 8.0.3

B-ACD scripts v3.0.0.2

UC540 factory default configurations

14
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Table 4 Cisco UC560 Software Packages

UC 560 Software

Pack Version

Filename

CCA Version
Compatibility

Component/Version Information

8.6.0 for UC560

UC560_8.6.0.zip (US/English)

CCA 3.2.1 and later

Cisco I0S 15.1(4) M4b

CUCME 8.6

CUE 8.6.3

B-ACD scripts v4

UC560 factory default configurations

8.2.0 for UC560

UC560_8.2.0.zip (US/English)

CCA 3.0 and later

Cisco I0S 15.1(2) T4

CUCME 8.2

CUE 8.0.3

B-ACD scripts v3.0.0.2

UC560 factory default configurations

Table 5 Cisco IP Phone Firmware Loads

IP Phone Firmware Loads

Table 5 lists the firmware releases required for the IP Phones that Cisco
Configuration Assistant manages. This table lists phone firmware loads that are
included with the UC500 software packs and have been validated for use with
CCA. If instructed to install a later version of phone firmware to resolve a support
issue, use the CCA Phone Load Management window or drag-and-drop phone

upgrade feature to install the phone firmware.

This most recent list of phone firmware loads is located at:
https://supportforums.cisco.com/docs/DOC-9827

SPA- SPA-
Softwere | 250 | 30 | sora | 7218 | 7920 | sass | a7 | 7285 | soxx | E307 | cesr | oos:
525G2 50X
8.6.0 74.9c 74.9c 5.0.4 104 1.4.1SR1 3.3.21 14.4 8.1.2 9.11 911 911 922
8.20 748 74.8a 5.04 1.04 1.3.4SR1 3.3.20 134 8.1.2 8.5.4S 9.0.2 854 -
8.1.0 74.6 74.6 5.0.4 104 1.3.4SR1 3.3.20 134 8.1.2 8.5.48 9.0.2 854 --
8.05 74.4 74.4 504 104 1.3.4SR1 3.3.20 134 8.1.2 8.5.3S - - -
8.04 74.4 74.4 5.04 1.04 1.3.4SR1 3.3.20 134 8.1.2 8.6.3S - - -
8.0.3 74.4 74.4 5.0.4 104 1.3.3 3.3.20 134 8.1.2 8.5.3S8 -- -- --
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Table 5 Cisco IP Phone Firmware Loads

SPA- | SPA-
6921 | 8961
Software | 525G 30X 7015 | 7921 7940 6901
Pack SPA- spa- | 791% | 7016 | 7925 7936 | 7937 | 960 | 79XX | G911 2221 3231
525G2 | 50X
802 743 743 | 504 | 104 133 3320 | 134 | 812 | 853S - - -
8.0.1 743 743 | 504 | 104 133 3320 | 134 | 812 | 853S - - -
800 74.2 742 | 504 | 104 133 3320 | 134 | 812 | 853s - - -
70.4 719 713c | 503 | 103 121/ | 3316 | 132 | 801 | sa2s - - -
131
713 719 713c | 503 | 103 124/ | 3316 | 132 | 801 | s42s - - -
131

Upgrading the UC500 and Installing Device Software

To upgrade software on the UC500 and other devices using CCA, choose
Maintenance > Software Upgrade.

For instructions on how to upgrade software on Cisco UC500 Series platforms,
see the CCA online help or the Cisco Configuration Assistant (CCA) Smart
Business Communications System Administrator Guide, available on Cisco.com.

Minimum Cisco |IOS Releases and Device Firmware Versions

Table 6 lists the minimum software releases required for the devices that Cisco
Configuration Assistant manages.

Table 6 Minimum Cisco IOS Release or Firmware Required

Device

Minimum Software Release

Cisco Unified Communications 500 Series
Model UC520

12.4(20)T2 or 12.4(22)YB

Cisco Unified Communications 500 Series
Model UC540

12.4(24)SB

Cisco Unified Communications 500 Series
Model UC560

Cisco I0S 15.0(1) XA

16
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Table 6 Minimum Cisco IOS Release or Firmware Required

Device

Minimum Software Release

Catalyst Express 500 switch

Cisco I0S 12.2(15)T9

Cisco Catalyst Express 520-8PC switch

Cisco 10S 12.2(35)EX

Cisco Catalyst Express 520-24PC switch 12.2(37)EX
Cisco Catalyst Express 520-24LC switch

Cisco Catalyst Express 520-24TT switch

Cisco Catalyst Express 520G-24TC switch

Cisco 800 Series router 12.4(4)T
Cisco 526 Wireless Express Mobility 42.61.4
Controller

Cisco 521 Wireless Express Access Point 12.4(10b)JX

Cisco Small Business Pro AP54 1N
Dual-band, Single-radio Access Point

Firmware version 1.8.0

Cisco SR520 Secure Router
(ADSL or Ethernet)

12.4(20)T4 and later

Cisco SR520-T1 Secure Router

SR520-T1 Software Pack

Cisco SA500 Series Security Appliances,
all models (SA520, SA520W, and SA540).

Software Version 1.1.65 or later

IMPORTANT Cisco SA500
Series software versions 1.1.42
and earlier are not supported for
use with CCA.

Use the SA500 Security
Appliance Configuration Utility to
manage the SA500 or upgrade to
version 1.1.65 or later of the
SA500 software.

Cisco Small Business Pro ESW500 Series
Switches

ESW500 Series 24 - and 48-port
models: Firmware version 2.0.3

ESW500 Series 8-port PoE
models: Firmware version 2.1.1 or
later.

Release Notes for Cisco Configuration Assistant 3.2.1
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Limitations and Restrictions

These limitations and restrictions apply:

IOS Limitations

After upgrading software pack to 8.6.0, the UC500 self-signed
certificate will be corrupt. If you are unable to connect to your UC500
using CCA, try connecting using tab Hostname / IP address after setting
HTTP protocol to “HTTP” in the Advanced Options tab. Then press the
Connect button. In addition, any SPA525 phones that are connected
using SSL VPN will fail to connect. You must regenerate certificates by
going to Configure > Security > SSL VPN and click the “Regenerate
Certificate” button (CSCty07520, CSCtz36465).

Passwords in the current I0S version in sofware pack 8.6.0 uses an
encryption method that is not backwards compatible with older I0S
versions. When attempting an IOS downgrade, the username/password
will be reset to factory default of cisco/cisco (CSCtz27359,
CSCtz27359).

Cisco phones CP8961/ CP9951 / CP9971

These phones have limited feature support; these are the only features
that are supported:

- Topology View

- Voicemail

- Auto Attendant

- Dial by name

- Blast group

- Dial Plan

- Normal Lines

These phones are not supported with Teleworker nor Multisite
environments.

There is no support for these phones in the Telephony Setup Wizard
(TSW).

Cisco Unified IP Color Expansion Modules (sidecars) are not supported.

Cisco Jabber for iPhone

DTMF tones orginating from Jabber for iPhone are not recognized by
Cisco Unity Express and some SIP service provides. To fix this issue, log
in to the UC500 using SSH/Telnet and enter the command:

18
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dtmf-relay rtp-nte sip-kpml

under the voice register pool for Cisco Jabber. (CSCts87199).

- The feature set of this application is limited when used with the UC500.
A shared line cannot be created between Cisco Jabber and a desk
phone.

- This application has limited feature support;These are the only features
that are supported:
- Voicemail
- Auto Attendant
- Dial by name
- Blast group
- Dial Plan
- Normal Lines

- This application is not supported with Multisite environments.
- A Cisco ASA is required for Teleworker deployment.
- There is no support for this application in the Telephony Setup Wizard.

- The iPhone should always be associated with the Voice Wireless LAN
SSID. Heavy data usage on the iPhone may cause voice quality issues
on WLAN.

- Voice quality is not guaranteed on Cisco Jabber.

- If an outbound proxy is configured under a SIP trunk, it may cause
incoming calls (internal and external) to Cisco Jabber to fail. To fix this
issue, log in to the UC500 using SSH/Telnet and enter the command:

no outbound-proxy system

under the voice register global command.

- For more information on Cisco Jabber, see
https://supportforums.cisco.com/docs/DOC-24508.

SPA8000 / SPA8800
- Only FXS ports are supported for configuration through CCA.

- These devices are not supported with Teleworker nor Multisite
environments.
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- There is no support for these devices in the Telephony Setup Wizard.

- For more information on the SPA8000 / SPA8800, see Configuring
SPA8800 / SPA8000 with the Cisco UC500,
https://supportforums.cisco.com/docs/DOC-24912.

Notes

The following notes apply to Cisco Configuration Assistant 2.0 and later:

When you start Cisco Configuration Assistant, Java determines whether the
resources it needs are available.

If they are not, Java displays the message Could not create Java
Virtual machine, and the session ends. To overcome this problem, open
the file C:\Program Files\Cisco Systems\CiscoSMB\Cisco Configuration
Assistant\startup\startup.properties (the default installation path), and
modify this entry:

JVM MAXIMUM HEAP=1024m
Replace 1024m with 512m.
This problem can occur on PCs with lesser specifications.

If the Cisco Configuration Assistant InstallShield Wizard fails to start, it is
likely there is a problem with the temporary folder location defined through
the environment variables TMP and TEMP. Assign a correct temporary folder
location to fix this problem.

Resolving Cisco Model 79xx Phone Upgrade Issues

After installing a UC500 software pack that contains version 8.5(3) phone firmware
for Cisco Model 79xx IP phones, Model 79xx phones being upgraded from
firmware versions prior to 8.5(2) may not register, or may register but still be
running an older version of the phone firmware. When the phone attempts to
upgrade to 8.5(3), you may see the message “Auth Fail” displayed on the phone.

This is due to a known issue with Model 79xx IP phones (the issue is documented
in the Cisco Unified IP Phone Release Notes for Firmware Release 8.5(3) (SCCP
and SIP (www.cisco.com/en/US/docs/voice_ip_comm/cuipph/firmware/8_5_3/
english/release/notes/7900_853.html#wp57602).
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STEP 1

STEP 2

STEP 3

STEP 4

STEP 5

STEP 6

STEP 7

For all SCCP firmware upgrades from firmware release versions earlier than 8.3(3)
to version 8.5(3) or later, you must first upgrade your firmware to version 8.5(2).
Once you have upgraded to version 8.5(2), you can upgrade your IP Phone to
version 8.5(3) or later. The problem affects these CCA-supported phone models:

Model 7975, 7970, and 7971
Models 7945 and 7965
Models 7942 and 7962
Models 7941 and 7961
Models 7906 and 7911
Model 7931

Perform the procedure in this section to correct the problem by upgrading the
phones to an intermediate load before upgrading them to version 8.5(3) firmware.

Before You Begin—Download the 8.5(2) Phone Firmware

Download the 8.5(2) phone firmware .zip file for each model phone that must be
upgraded. This is the intermediate load that will be used.

IMPORTANT You must download the 8.5(2) version of the phone firmware. The
8.5.2SR1 load cannot be used for this purpose.

To locate the 8.5(2) version of the SCCP (Skinny Client Control Protocol) version of
the firmware for the desired phone models, follow these steps.

Log in to Cisco.com (you must have a Cisco.com login to download phone
firmware).

Open a Web browser and go to www.cisco.com/go/software.

On the Download Software page, choose Voice and Unified Communications >
IP Telephony > IP Phones > Cisco Unified IP Phone 7900 Series > Cisco
Unified IP Phone <79xx>.

Click the Skinny Client Control Protocol (SCCP) Software link.
In the Search Release field, enter 8.5(2) and click Go.
Click the link to the 8.5(2) software.

Download the .zip file for the selected model. For example, the filename for Model
7975 phones is cmterm-7975-sccp.8-5-2. zip.
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STEP 8

STEP 1

STEP 2

STEP 3

STEP 4

Repeat these steps to download 8.5(2) firmware for each of the phone models to
be upgraded.

Upgrading the Phone Firmware

Perform these steps to upgrade the affected Model 79xx phones with version
8.5(2) firmware as an intermediate step and then upgrade them to version 8.5(3)
firmware.

IMPORTANT The embedded TFTP server in CCA is used for drag-and-drop file
uploads. Before performing the upgrade, disable any third-party TFTP services
running on your PC and check the firewall and network security settings on your
PC to make sure that TFTP packets can be transmitted between your PC and the
UC500.

Launch CCA and open the Topology view.

Drag and drop the .zip file with the 8.5(2) phone firmware onto the UC500 icon in
the Topology view.

Do not change the .zip file name or unzip the file.

In the File Upload dialog, click Upload.

CCA extracts the files from the .zip archive and copies them to a temporary
directory on the UC500 flash. If there are any TFTP and load configurations for
8.5(3), these are replaced with the intermediate 8.5(2) load and files.

The Phone Firmware Update dialog shows the progress of the upload. Once the
files are copied to the flash, CCA displays the following message:

“Disconnect all Cisco Model <Model Number> IP phones, and then reconnect
them. Wait until the phone firmware upgrade completes, then click OK to
continue.”

Disconnect and then immediately reconnect the indicated phones. Wait for the
upgrade to complete on all the indicated phones.

IMPORTANT Do not click OK until all of the affected phones have upgraded their
firmware and re-registered. The upgrade takes at least 10 - 11 minutes and the
phones will restart. To verify that the interim load has been installed, press the
settings button on the phone and navigate to Settings > Status > Firmware
Versions > Load File. The interim load filename is SCCP45.8-5.2S.
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After the interim upgrade completes, CCA removes the interim 8.5(2) TFTP and
load commands, replaces them with the 8.5(3) TFTP and load commands, and
then issues a reload/reset command to the phones to load the 8.5(3) firmware.
Once the final reload and reset completes, the phones will be upgraded to the
8.5(3) firmware and re-register with the UC500.

STEP 5 Repeat these steps for each different phone firmware .zip file.

Cisco SBCS Features Supported Within CCA

The Cisco Smart Business Communications System Feature Reference Guide
provides guidance to partners on the features that can be configured using the
latest releases of CCA. The information is categorized by Voice, Switching,
Wireless, and Secuirity.

This guide is available on the Resources tab on the main Cisco Smart Business
Communications product page (www.cisco.com/go/sbcs). From within CCA you
can choose Partner Connection > SBCS Feature Guide to access the guide.

Open Caveats

This section describes the open caveats that could create unexpected activity in
this software release.
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Table 7 Open Caveats in Cisco Configuration Assistant 3.2.1 and earlier

Ref Number

Description

CSCsx86872

A DID does not register when Service Provider SIP trunk configuration is loaded from
different PCs.

Symptom Some Day2 additions or modifications under Telephony are misconfigured
for a custom SIP Provider. For example, an added DID may not register correctly. The
custom SIP Provider name is shown in the SIP Provider dropdown list but no Template
information is displayed. The CCA Application log contains this error: ++: ERROR: :
SIPData: SIP Provider read from device is not supported by any template: <PROVIDER
NAME>

Workaround To get around this problem, use only the original CCA installation to
make Telephony related modifications OR add the custom SIP Provider template
(.xml) to all CCA installations which may configure the same UC500.

CSCtn48997

The voice VLAN static route is missing when changing the voice and data VLAN from
the default IP.

Symptom This will happen when an SR520 and UC are not initially configured by the
Telephony Setup Wizard. It will not happen if the Telephony Setup Wizard was used to
configure an SR520 and UC.

Workaround Manually add static route in SR520-t1 to a newly created Voice VLAN
IP network.

CSCtl06532

SIP Trunk: Add configuration to remove second “c” header in SDP.

Symptom Multiple “c” headers are sent in the SDP. This causes issues when the
upstream NAT device sees only NATs on the ¢ header. Service Provider SIP proxy
adheres to RFC3264 and only looks at media level c= line and ignores session level c=
line.

Workaround None.

CSCtk96606

Icon for the 6945 IP Phone is incorrect in the Topology View.

Symptom The icon used for the 6945 IP phone is incorrect in the Topology View.

Workaround None. The Model 6945 IP phone is not supported by CCA. CCA
discovers the phone and displays it in the Topology view, but since itis not a
supported phone, CCA displays the default phone icon in the Topology view.
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Table 7 Open Caveats in Cisco Configuration Assistant 3.2.1 and earlier

Ref Number Description

CSCtk76997 Expansion modules added via the Telephony Setup Wizard do not appear on the Users
and Phones screen.
Symptom The Users and Phones screen does not show phone expansion modules
that were added via the Telephony Setup Wizard.
Workaround None.

CSCtj56444 Program Compatibility Assistant popup appears when installing the CCA on a PC
running Windows 7.
Symptom Program Compatibility Assistant appears after a full CCA installation,
warning the user that the installation might not have installed correctly.
Workaround Choose the option "This program installed correctly” in the Program
Compatibility Assistant popup dialog.

CSCti25821 Anyconnect 2.5 does not work with the SR520-T1 SSL VPN sever.
Symptom An SR520-T1 running SSL-VPN sever with version 2.5 of the Anyconnect
client (anyconnect-win-2.5.02 17-k9.pkg) cannot connect to the SSL VPN server due to a
certification error.
Workaround Use version 2.3 of the Anyconnect client (anyconnect-win-2.3.0254-
k9.pkg).

CSCtgb0723 SIP Trunk: Support individual DIDs for diversion header on SIP trunks.
Symptom When the UC500 is using SIP trunks for PSTN access and there are hairpin
calls (from the PSTN to the UC500, and then back out to the PSTN), the diversion header
for forwarded calls on SIP INVITE from the UC500 only has the main number DID.
Workaround None.

CSCta94933 Need to be able to use a loopback IP address as a source IP for XO SIP Trunk.

Symptom XO SIP trunk requires the ability to specify a source IP address for SIP and
RTP packets on the UC500.

Workaround XO SIP trunk provider will provision the circuit with a source IP
address to be the same as the internet IP address on the XO circuit.
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Table 7 Open Caveats in Cisco Configuration Assistant 3.2.1 and earlier

Ref Number Description

CSCsz29268 WebEx PhoneConnect: Locale change is not picked up unless the administrator enters
the WebEx PhoneConnect application screen.

Symptom The user changes the CME locale after having configured WebEx
PhoneConnect and the phone does not pick up the new language. This occurs only if the
WebEx PhoneConnect configuration windows in CCA are not accessed after the CME
locale is changed.

Workaround Set the CME locale before configuring the WebEx PhoneConnect
application.

Alternatively, if after setting up the PhoneConnect users and changing the CME locale,
the WebEx PhoneConnect screens on user phones do not have the new language, do
the following:

1. Exit any WebEx PhoneConnect configuration windows that may be open in CCA.
Close any open WebEx PhoneConnect application screens on IP phones.

2. In CCA, go to Applications > Smart Business Applications, select the WebEx
PhoneConnect application, click Setup Options and log into the WebEx
PhoneConnect application. This will open the PhoneConnect Application Main
window and send the CME locale to the PhoneConnect application.

3. Click OK or Apply.

If, after performing the actions listed above, the new language does not appear on the
phones do the following:

1. Exit all WebEx PhoneConnect configuration windows and IP phone screens.
2. Restart CUE from the Maintenance window (Maintenance > Restart/Reset).

3. Wait for the CUE restart to finish.

CSCsx62251 WebEx PhoneConnect: Join before meeting start option is only available to the host, not
the attendee.

Symptom When scheduling a non-audio WebEx Meeting Pro with an option to let
attendees join x minutes before start time, alerts with the Call button x minutes before the
start time are only sent to the host. Alerts for the attendees do not display a Call button
until the meeting start time.

Workaround None.
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Table 7 Open Caveats in Cisco Configuration Assistant 3.2.1 and earlier

Ref Number Description

CSCsx20742 | WebEx PhoneConnect: Intermittently phones cannot dial into meeting.
Symptom Intermittently, phone users are unable to have PhoneConnect auto-dial into
the meeting. After the Call button is pressed, the phone remains on the dialing screen,
and no audio is heard.
Workaround To recover, the phone the user must manually end the call. The phone
user can then press the Services button, select WebEx Meetings > Today, click
Details, then either click Call to retry the auto-dial, or manually dial in to the meeting
using the information from the meeting details page.

CSCsx10880 WebEx PhoneConnect: Alternate host and host cannot both join meeting.
Symptom If a user creates a meeting with an alternate host, the host and the alternate
host cannot both join the meeting. The first host to join the meeting is granted host
privileges and the other host cannot join the meeting.
Workaround None.

CSCtr20290 Telephony Setup Wizard: Issues uploading a .wav file in prompt management.
Symptom
1. When uploading a .wav file of 1MB or less, and not recorded in G.7 11 u-law, an error
message is displayed, but the length of the wave file is retained and shown on the
screen.
2. When a .wav file, of IMB or more is uploaded, it is not accepted. however no error
message is displayed
3. When a .wav file, which is not recorded in g.711 u-law and more than 1MB, is uploaded
a no error message is displayed.
Workaround None.

CSCtr19665 Enable-Disable Voice mail resets the Dial-by Name configuration.
Symptom Configure > Telephony > Call Handling > Dial-by Name configuration resets
to none, and does not inform the user.
Workaround None.

CSCtr14585 Smart ports: Maximum hosts field issue in Switch port setup.

Symptom Selected port role is configured on the port.

Workaround Enter a value 1 - 10 in the Maximum Hosts field, or leave the default
value if present.
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Table 7 Open Caveats in Cisco Configuration Assistant 3.2.1 and earlier

Ref Number Description

CSCtr11628 Users listed under Hunt Group and Incoming Dial Plan do not display completely.

Symptom Creating Hunt Group and Call Blast Group through Telephone Setup Wizard
allows the option to forward the calls to some destination (either Voice mail or other
Extension), and the users and users list is not fully displayed when forwarded to another
user. Not able to select the user, other than the list showing on the screen.

Workaround Do not configure more than 34 users. Configure more users in expert
mode.

CSCtr06309 Call accounting to FTP server via CCA fails.
Symptom Enabling call accounting to FTP server fails.

Workaround Manually backup from flash.

CSCtq78188 Changing the installed language does not modify the configuration under CCN trigger
SIP.

Symptom Changing the installed language to another language (that is, Spanish to
Dutch) does not modify the configuration under ccn trigger sip; thus calling to the Dutch
VM pilot number does not play any voice, and the call disconnects after sometime.

Workaround Before changing the installed language perform a factory reset, then
proceed with the locale upgrade or software upgrade.

CSCtgb4784 Deleted user still has userid and extension information in mailbox.

Symptom After deleting a user with a mailbox at Telephony > Users and Extensions >
User and Phone > User Extensions Ul, incomplete mailbox information may appear under
Telephony > Users and Extensions > Voicemail > Mailboxes Ul (i.e., a userld without the
first name and last name).

Workaround Click refresh in the User and Phones window.

CSCtg55689 Ports > Switch Port Settings > Runtime Status > Device is always Unknown.
Symptom Connected device type is not shown in Runtime Status of Switch Port.

Workaround To view devices connected to the switch, click the "Topology Options"
button in Topology View, then select "Link Interface ID" in the "Show Information" tab.
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Table 7 Open Caveats in Cisco Configuration Assistant 3.2.1 and earlier

Ref Number Description

CSCtq04998 Smart port: Modified port role shows empty when multiple modification is selected.
Symptom This happens only when multiple ports are selected to modify.

Workaround Select single port then click Modify to see the smartport role that is
configured on the port.

CSCto04948 Not able to select the users in the call routing section of the Telephony Setup Wizard if
the number of users is greater than 35.

Symptom Users are not listed in Incoming Call Handling section of the Telephony
Setup Wizard if there are more than 35 users.

Workaround Press the down arrows by assuming the count.

CSCtn55711 Changing the subnet of third octet will not change the DHCP range of the IP addresses.

Symptom Changing the subnet mask of third octet will not change the DHCP range of
IP addresses.

Workaround There is no workaround in TSW. Changes can be made in expert
mode.

CSCtn56620 Voice Mail personalized settings are not completely restored from a backup.

Symptom User is prompted for the Voice Mail password and then prompted again to
personalize the Voice Mail settings.

Workaround Add Voice Mail and personalize settings again after password
prompt.

CSCtn39148 Telephony Setup Wizard: Deleting the last digit in the extension field retains the original
value.

Symptom While running Telephony Setup Wizard, and attempting to delete the last
number on FXS, the Voice Mail number filed does not get deleted and returns to the
original pre configured value.

Workaround No workaround in Telephone Setup Wizard. Make the changes in
expert mode.

CSCtn38381 Telephony Setup Wizard: Cannot remove a pre-populated userid.
Symptom Not able to change the Userid.

Workaround None.
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Table 7 Open Caveats in Cisco Configuration Assistant 3.2.1 and earlier

Ref Number

Description

CSCtn14032

System uptime for AP54 1Ns always shows zero.
Symptom System uptime in Inventory dialog is always shown as zero.

Workaround No workaround in CCA. Launch Configuration utility of device and
check system uptime.

CSCtl45859

Using CCA to reset to factory default does not restore default Voice Mail language to US
English.

Symptom After resetting to factory default, the VM language is not restored to US
English.

Workaround Reinstall software pack with format flash and then apply the factory
default.

CSCtj67013

A user profile in use should not be deleted.

Symptom The user profile which is in use can be deleted. If deleted the user can be
logged out of the phone and could not login again.

Workaround Login a phone using a user profile. Then delete the user profile from
CCA, EM window.

CSCtw66086

CCA is not creating the appropriate Access list/NAT with respect to Multisite.

Symptom Enabling firewall after configuring Multisite does not generate proper NAT
mappings.

Workaround Configure Firewall or NAT before configuring Multisite.

CSCts31263

The alternate locale pack selected, along with Software Upgrade (without factory
default), fails to install the alternate language prompts in the CUE.

Symptom When an alternate locale pack is selected along with SW Upgrade (without
factory default) it fails to install the alternate language prompts in the CUE.

Workaround Upgrade the locale pack using ‘Install locale pack’ option.
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Table 7 Open Caveats in Cisco Configuration Assistant 3.2.1 and earlier

Ref Number Description

CSCty78255 When modifying SIP Trunk service providers, the voice class codec settings are
reapplied. Existing outbound dial-peers that depend on voice class codec lose this
configuration, reverting back to default G729.
Symptom SIP Trunk calls may fail.
Workaround When making changes to SIP Trunk Service Provider, be sure to re-
enter any Digest Authentication or User Credentials. Also, if using voice codec other
than G729, SIP trunk option may need to be reapplied to the Outgoing Dial Plan.

CSCtw80672 | Outgoing Dial Plan auto selects 9 as the Access Code.
Symptom The Default Access Code will still show the correct number, but all the
Outgoing Number options will have '9' configured as the Access Code.
Workaround Manually change the Access Code for all the Outgoing Numbers
options to match the Default Access Code.

CSCtt92348 DIDs for extension numbers associated with SIP Phones are not registered for SIP
Trunk.
Symptom SIP calls to the DID number will fail. The SIP Trunk service provider rejects
the call due to lack of registration.
Workaround None.

CSCty26929 Add DID support for FXS/DID lines that are non-enbloc.
Symptom When FXS/DID trunk or T1/E1 CAS lines are used for inbound calls, call
forwarding to voice mail may fail.
Workaround Manually configure ‘phonenumberE164 in CUE via CLI or CUE GUIL.
Configure DID to point to Floating Extension which has CFA pointing to internal
extension.

CSCtx86440 Unable to add DID for FXS/DID trunk or T1/E1 CAS lines.

Symptom Validation error is encountered preventing addition of FXS/DID trunk or T1/
E1 CAS lines. The validation error is incorrect.

Workaround None.
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Table 7 Open Caveats in Cisco Configuration Assistant 3.2.1 and earlier

Ref Number Description

CSCtz93776 Phone firmware does not upgrade in phones after Software Pack upgrade.
Symptom When upgrading software pack on a UC500 that is not in factory default
state, phone firmware is installed in flash. But the Load commands and tftp commands
are not updated properly. So the phones do not upgrade themselves with the new
firmware.
Workaround After upgrading, go to the Phone Load Management window and
manually upgrade the phone firmware.

CSCua00673 | Incoming calls fail to internal SIP endpoints, such as SIP desktop phones or Jabber for
iPhone.
Symptom Incoming calls fail. Call traces show UC500 returns cause '403 Forbidden'
Workaround Add the following command so that internal SIP endpoints ignore the
Outbound Proxy Server configured for SIP Trunk.
UC500#config terminal
UC500(config)#voice register global
UC500(config-register-global)#no outbound-proxy system

CSCtz36465 SSL VPN client (SPA525 phone) fails to connect VPN session.
Symptom SPA525 phone shows "Failed to obtain WebVPN cookie"
Workaround After image upgrade, create a new certificate and reload UC500.
For example (using CCA)
You may regenerate certificates by going to Configure > Security > SSL VPN and
click the “Regenerate Certificate” button.
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Resolved Caveats in CCA 3.2.1

This section describes the resolved caveats for the current release.

Table 8 Resolved Caveats in Cisco Configuration Assistant 3.2.1

Ref Number Description

CSCtn10171 An extra UC icon shows up on the topology after using the Telephony Setup Wizard.

CSCtg67250 The last four buttons of the 7931 phone becomes inactive after applying a custom
template.

CSCtr03765 The Call Blast Group did not support Dynamic login/logout through softkeys.

CSCtt00298 Error messages display in the Outgoing Dialing Plan when changing locale.

CSCtu02294 Changes to channel signaling do not push the configuration to the router.

CSCtu26773 Registrar Server Expiry may not be applied without the Registrar Server

CSCtu42616 PRI ISDN map is automatically restored on reconfigure of PRI.

CSCtw68473 | Itis not possible to install a locale pack on the UC500 (software pack 8.2).

CSCtx00912 SIP trunk option shows up twice in Incoming Trunk.

CSCtx01717 Smart port for an access point failed on the UC520.

CSCtx45676 Unable to remove old holidays.

CSCtx56559 Unable to configure T1 ports with analog signaling after Multisite Confguration on the
UC520.

CSCtx86159 The FXS port is removed when the refresh button is clicked.

CSCty29419 The documentation is ambigous regarding caller-id playback for voicemails.

CSCty46264 The button layout for 7931G is missing in the template.

CSCty72278 There should be uniqueness checks at the user and phone using case-insensitive string
comparisons.

CSCtz12004 The Australia Numbering Plan Locale for Outgoing Dial Plans is generating two dial-

peers for Emergency numbers.
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Cisco Unified Communications 500 Series Configuration
Support Policy

Information about Cisco Unified Communications 500 Series Configuration
Support Policy is available at:

https://supportforums.cisco.com/docs/DOC-14855

NOTE: Requires partner login to access.

Cisco Small Business Support Community

The Cisco Small Business Support Community site provides resources to assist
VARs and Partners with design, implementation, and maintenance for Cisco SBCS
platforms. To access the Cisco Small Business Support Community, point your
web browser to the following URL:

www.cisco.com/go/smallbizsupport

Documentation for Cisco Configuration Assistant

The following documentation is provided for Cisco Configuration Assistant:

Cisco Configuration Assistant Smart Business Communications System
Administrator Guide, a comprehensive, end-to-end guide that covers all
features and configuration tasks that can be performed using CCA.

The administration guide is also available in PDF format through the online
help system in CCA.

Online help. To access online help, click the Help button provided in CCA
windows and dialogs, choose Help > Contents from the menubar, or press
F1 to display Help for the active window.

These release notes.

To access documentation for Cisco Configuration Assistant on Cisco.com, visit the
following URL.:

www.cisco.com/en/US/products/ps7287/tsd_products_support_series_home.html
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Where to Go From Here

Cisco provides a wide range of resources to help you and your customer obtain
the full benefits of Cisco Configuration Assistant.

Cisco Configuration Assistant

Cisco Configuration Assistant www.cisco.com/go/configassist

Product Page

Cisco Configuration Assistant Technical www.cisco.com/en/US/products/ps7287/
Documentation tsd_products_support_series_home.html

Cisco Small Business

Cisco Partner Central for Small Business www.cisco.com/web/partners/sell/smb
(Partner Login Required)

Cisco Small Business Home www.cisco.com/smb

Cisco Small Business Support

Cisco Small Business Support Community | www.cisco.com/go/smallbizsupport

Cisco Small Business Support and www.cisco.com/go/smallbizhelp
Resources
Phone Support Contacts www.cisco.com/en/US/support/

tsd_cisco_small_business
_support_center_contacts.html

Cisco Small Business Firmware Downloads | www.cisco.com/cisco/software/navigator.html

Cisco Smart Business Communications System and Components

Cisco UC500 software packages and www.cisco.com/go/uc500swpk
localization files
(Cisco.com Login Required)

Cisco Smart Business Communications www.cisco.com/go/sbcsresources
System

Cisco Unified Communications 500 Series | www.cisco.com/go/uc500resources

Cisco Unified Communications 500 Series | www.cisco.com/en/US/partner/prod/collateral/
Configuration Support Policy netmgtsw/ps7256/ps7287/
cisco_cca_cli_support_policy.pdf

(This link requires CCO login)

Cisco SPA500 Series IP Phone www.cisco.com/go/spa500phones

Cisco SPA300 Series IP Phones www.cisco.com/en/US/products/ps10998/
tsd_products_support_series_home.html

Cisco Unified IP Phones 7900 Series www.cisco.com/en/US/products/hw/phones/
ps379/
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Cisco AP54 1N Access Point

www.cisco.com/go/ap500resources

Cisco SA500 Security Appliance

www.cisco.com/go/sab500resources

Cisco ESW500 Series Switches

www.cisco.com/go/esw500resources

Cisco Small Business 300 Series Managed
Switches

www.cisco.com/go/300switches

Cisco 200 Series Smart Switches

www.cisco.com/go/200switches

Cisco PVC2300 (Audio/PoE) and
WVC2300 (Audio/Wireless-G) Business
Internet Video Cameras

www.cisco.com/go/smallbizcameras

Cisco Secure Router SR500 Series

www.cisco.com/go/sr500

License Notices

Open Source License Notices

www.cisco.com/go/osIn

The Open Source License Notice for CCA 3.2.1 is
available on the CCA software download page on
Cisco.com.

Any Internet Protocol (IP) addresses used in this document are not intended to be actual addresses. Any
examples, command display output, and figures included in the document are shown for illustrative purposes
only. Any use of actual IP addresses in illustrative content is unintentional and coincidental.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and
other countries. To view a list of Cisco trademarks, go to this URL: www.cisco.com/go/trademarks. Third-
party trademarks mentioned are the property of their respective owners. The use of the word partner does
not imply a partnership relationship between Cisco and any other company. (1110R)

© 2012 Cisco Systems, Inc. All rights reserved.

Document Number: OL-25658-02
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